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USE AND DISTRIBUTION NOTICE

• Santa Clara County RACES authorization is granted to use and 
duplicate this material as-is as long as this page and the 
copyright notices on each page are included, acknowledging 
Santa Clara County ARES/RACES as the holder of the 
copyright. 

• Permission is granted to adapt this presentation to your 
needs as long as you acknowledge our copyright and include a 
note similar to "adapted with permission from Santa Clara 
County ARES/RACES”

• For additional information on training or any of our programs 
send an email to: info@scc-ares-races.org
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2021 Year End
Summary, Update, 

Preview
Santa Clara County ARES®/RACES

Revised:  Dec 11, 2021
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HOUSEKEEPING

• Introductions
• Pen/pencil & paper
• Distractions

– Cell phone

– Pets

– Other household members

• Questions – “Raise Hand”
• Breaks
• If we lose Internet connection
• Course Credit

• No wandering or exploring other 
areas of the building.
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Agenda

• Packet Update
• October Exercise and SET
• October Exercise Packet Operations
• Net Control Updates
• Message Passing
• BBS, Network Update
• New FCC Station Evaluations
• Volunteer Hours Reporting
• 2022 Training
• Credential Program
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Packet Update

Jim Oberhofer, KN6PE
Revised 01-Dec-2021
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6

Packet Exercise
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Weekly Packet “Practice”

2021… by the numbers (7-Dec-2020 thru 30-Nov-2021)

7

Monday Tuesday ’21 ttl

Ttl Practice Messages sent 1365 1861 3226

% Correct all the time 96.8% 96.5% 96.6%

Unique Ave # of 
Participants/Night 26 35 30

’18 ttl

2116

93.2%

25.5

’19 ttl

2844

93.7%

29

’20 ttl

3138

95.5%

31
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Weekly Packet “Practice”

• See the “Standard Packet Check-In/Out Message” App Note 
under…
https://www.scc-ares-races.org/data/packet/index.html#app-notes

• See the Practice Message, Subject section under…
https://www.scc-ares-races.org/data/packet/weekly-packet-
practice.html#Message
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What’s new with 
Outpost and PackItForms
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What’s in the box?

• SCCo Integrated Packet Installer 160
• Outpost Packet Message Manager

– GUI-based interface for managing packet communications
– Makes using packet as simple as using e-mail

• PackItForms
– Next generation HTML-based forms for use with Outpost
– Headless Chrome for auto-printing support

• PacFORMS
– HTML-based forms for use with Outpost
– Since 2007, simplified forms-based data entry, reduced network 

bandwidth
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10



2021 Year End Summary 12/11/2021

11Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

SCCo Installer v160
July 2021

• Digitally signed Outpost installer and programs
• Minor functionality changes to address SCC 

defects

11

Outpost v3.5.0*

PackItForm 3.2.1*
• Digitally signed PackItForm installer and programs
• No functionality changes

*See the release notes for details
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What was new, different in 2021?
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Top 7 packet “what’s new” items for 2021

7.  Packet Training on Zoom
6.  Windows 11
5.  Event Documentation
4.  Check-in, Check-out messages
3.  Resend Options (and the Subject Line)
2.  Manual Packet (and the Subject Line)
1.  Packet as a repeatable process
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7.  Another year on Zoom
Packet training in pajamas 

• Ran all the packet classes by zoom
• Zoom registration helped track who actually showed up
• Office Hours offered a chance for troubleshooting, 1-on-1 chats, and 

general Q&A
• Updated homework assignments
• Completing the homework was prerequisite for class credit

– Packet IIIA; Outpost and PackItForms 79%
– Packet IIIB; Applying packet to the Field 94%
– Packet II; What!?  No Outpost?  Manual Packet 68%

14Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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6. Windows 11

• Windows 11 was released on October 5, 2021
– Price: Free upgrade for existing Windows 10 users
– new desktop look, a major UI redesign, changes to the core Microsoft 

OS apps and services.
– Microsoft says Windows 11 was built for gamers.

• But… not every Windows 10 PC is Windows 11 compatible

• The good news:  PackItForms and Outpost works fine on W11
• SCC RACES packet PC recommendation:

– Laptop or larger netbook running at least Windows 8.1
(end of W8.1 extended support… January 10, 2023)
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5. Event documentation
Its all about the money

• Excerpts from the FEMA | Office of Inspector General report titled “Summary of 
Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”

• “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15 percent, in 
questioned costs out of the $10.9 billion that we audited, which we recommended FEMA 
disallow as ineligible and unsupported costs.”

• “In fiscal year 2016, we found $155.6 million, or 23 percent, in questioned costs out of the 
$686 million that we audited, which we recommended FEMA disallow as ineligible and 
unsupported costs.” 

• In cases where FEMA payments were made and claims later disallowed, recipients 
would be required to repay these payments, with audits sometimes taking place 
years later.

• Because your documentation could be a used as part of the City’s justification for 
either an expense reimbursement or cost recovery request, ensuring the accuracy 
and completeness of what we submit is critical.
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How does this apply to us?

• If tracked properly, hours worked volunteering can be reimbursed by FEMA 
under the guidelines for “volunteer labor” (44 Code of Federal Regulations (CFR) 
13.24 (c) (1)). 

• The reimbursement rate would depend on the volunteer and the type of work 
completed.

• The reimbursement rate could be in the range of $20 to $50 / hr (estimate)
• For instance:

• And… city staff hours are reimbursable if overtime is extraordinary or the work is 
not normally budgeted in their job.

• BUT, it all depends on getting the documentation right.

Your_ARES 10 10 # volunteers
Hrs / day 12 120 Volunteer hours / day
Days / event 10 1200 Volunteer hours / event
$/hr $35 $42,000 Reimbursement
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What can go wrong… a case in point

• From May 1 through May 2, 2010, Tennessee experienced high winds 
and flooding which resulted in widespread loss of power.

• The disaster forced residents to vacate their homes and to require food 
and basic housing.

• The Applicant opened a disaster recovery center and staffed it with 
volunteers.

• The Applicant requested credit toward the calculation of the non-
Federal cost share for volunteer labor, donated equipment, and 
donated materials.

• FEMA initially granted Applicant’s request for a $65,416 credit but later 
de-obligated $57,714 because volunteer hours were not properly 
documented.
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• During a Packet Deployment, you will produce the following:
1. ICS 214-SCCo Unit Activity Log
2. ICS 309-SCCo Communications Log (if participating on a voice net)
3. All third party sent & received PackItForms and plain text messages
4. All sent and received operator to operator packet messages
5. ICS 309 Communications Log (packet)
6. Any Form 1 / hand-scribbled / sticky notes, documentation.

• Applies to exercises and real activations
• When your shift is over, your supervisor will tell you what to do, such as:

– Submitting all documentation (to whom and how)
– Preparing the packet station for the next use (archiving your shift)

Archiving event documentation
Introduction
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• The job is not done until the paperwork 
is complete, archived, and submitted.
– Every scrap of paper used during an activation is part of the event or 

incident and goes to the Documentation Unit (or your Supervisor)
• It must be legible (print)
• Use one side only

– These are legal documents that may be needed to defend decisions
– Most of this documentation is ‘discoverable’
– If it is not in the documentation, then it did not happen
– Some documentation is specifically created after the event or 

incident, such as the After Action Report

• And, all this applies to our packet operations

Event documentation
Introduction
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1. Create the ICS 309 Communication 
Log

a) Outpost, Forms > ICS 309 Comm Log. 

b) Select Period Tab, then Range for when 
your shift (or event) occurred.

c) Select Output Tab, then which printer

NOTE: If you do not have a printer, then select 
the Microsoft Print to PDF printer to produce a 
.pdf file.

d) Press Build Data Set, then press Print.

e) If you paper-print this form, then sign the 
ICS 309.

f) Deliver this report to your supervisor.

Archiving event documentation
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2. Create a printable message listing
a) From Outpost, File > Save All.  

b) Creates an Ascii-formatted file
of all messages in the current folder
with a Page Break between each 
message.  

c) Repeat for any other folder where 
event messages were stored.

d) This file could be printed to generate 
one message per page or cut-n-paste 
out a specific message.

e) Deliver this file to your supervisor.

Archiving event documentation
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3. Create a Message Archive 

a) From Outpost, File > Export, then 
select “All Folders“ (for your entire 
system).  

b) Use meaningful file names. 

c) The Export process will create an 
Outpost Archive File (.oaf).

d) This file later can be imported back 
into Outpost to restore the archived 
messages to their original folders.

e) Deliver this file to your supervisor.

Archiving event documentation
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4. Reset Outpost for the next event

a) You are about to DELETE ALL MESSAGES in Outpost

b) Make sure you set up the SCC Notices message folder

c) Export (backup) the SCC Notices folder (File > Export…)

c) Delete all Outpost messages (File > Delete All Messages, Yes)

d) Restore the SCC Notices (File > Import…)

e) You now have a clean system for the next event or incident.

f) Inform your supervisor that this task is complete.

Archiving event documentation

STOP! Do not proceed until you have created a 
Message Archive>All Folders first.

STOP! Do not proceed until you have
permission from your supervisor.
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• Properly formatted Check-In/Out messages are important
– Recipient can easily find them among other messages in the In Tray
– They inform the EOC or other “net control” which stations are ready
– They are part of DSW supervision 

• General rules during field assignments
– Check in and out using your assigned Tactical Call, not your FCC call
– Check-in as soon as the station is ready
– Check-out before shutting down the station using your Tactical Call
– Always send as plain text messages (not forms)
– Always use [HandlingOrder] = “_R_”

• Handling Order = R (Routine)

– Always follow the standard subject line format
• With specific check-in/out details for subject and message body

4. Check-In/-Out Messages

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 26
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• Tactical Check-In Format:
– Subject: [MsgNbr]_R_Check-In [TacticalCallSign], [TacticalName]
– Body: Check-in [TacticalCallSign], [TacticalName]

Present are:
[List of FCC call signs and full names, one per line]

• Example:
– Subject: SH1-234P_R_Check-In XNDSH1, Xanadu Shelter 1
– Body: Check-in XNDSH1, Xanadu Shelter 1

Present are: 
W6XRL4, Herman Munster

• Check-Out format is the same, except replace “Check-In” with “Check-Out”

https://www.scc-ares-races.org > Data Networking > Packet BBS > Standard Packet Check-In/Out Message

Check-In/-Out:  Tactical
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• Unless your local jurisdiction requires it, it is unlikely you will 
need to use an individual check-in/out.  But, if you do…

• Individual Check-In Format:
– Subject: [MsgNbr]_R_Check-In [FCCCallSign], [FullName]
– Body: Check-in [FCCCallSign], [FullName]

• Example:
– Subject: XRL-123P_R_Check-In W6XRL4, Herman Munster
– Body: Check-in W6XRL4, Herman Munster

• Check-Out format is the same, except replace “Check-In” with 
“Check-Out”

Check-In/-Out:  Individual
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You did what?!!?

• You just sent a message, but …
– it was addressed incorrectly, or
– it was sent to the wrong BBS, or
– you forgot to include all recipients, or 
– it was incomplete, or 
– it was the wrong message, or
– any number of other problems!
And, you don’t want to type it all back in!  What now?

3. Message Resend

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 29
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Resend Options (and the Subject Line)

• Three types of Message Resend 
1. Text Message, same Message ID or new Message ID
2. PackItForm Message , same Message ID
3. PackItForm Message , different Message ID

30Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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Resend a message previously 
sent.   
• Sent folder, open the message
• Actions > Resend…  choose 

option
• Edit the message. 
• For Resend, Same Msg ID,

manually change the Message ID 
from -###P to -###R for Resend. 

• Make whatever other changes 
you need to make, then

• Press Send, then Send/Receive.

Resend option – Text Messages

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 31
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Resending PackItForm Messages
depends on your option.
• Sent folder, single-click on the message  

to highlight it (not open it)
• Actions > Open enhanced msg as text
• Once the text opens, click on Actions > 

Resend… choose Same Message ID
• PackItForm opens a new copy in the 

Browser, ready for editing.
• Manually change the Message ID from 

-###P to -###R for Resend. 
• Make other changes and continue as 

usual.

Resend option – PackItForm Messages
Same Message ID…
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• Get the Next Message Number: 
– In Outpost, Tools > Report Settings
– Note the Next Message value.  This is 

the number to use.  Do not change it!

• Sent folder, single-click on the message  to 
highlight it (not open it)

• Actions > Open enhanced msg as text
• Once the text opens, click on Actions > 

Resend… choose New Message ID
• The PackItForm will open in the browser.
• Manually change the PackItForm Origin 

message number with the number you 
noted above.  

• Make other changes and continue as usual.

Resend option – PackItForm Messages
New Message ID…
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2. Manual Packet (and the Subject Line)

• Without Outpost, you have to manual 
Message ID tracking.  One method:  

• Any piece of paper will do.
• Create a list of message IDs to use.

– Use the ‘M’ suffix to indicate this is 
a Manual message and not conflict 
with Outpost’s ‘P’ (for packet) suffix.

• When you use one, cross it out.
• Example: given this list, your next 

Message ID is X14-303M.

• For packet messages sent or received, 
enter the Message ID in the next 
message; don't forget your ICS 309.

Xanadu Fire Station 14
Manual Message ID List
Herman Munster, W6XRL4

X14-301M
X14-302M
X14-303M
X14-304M
X14-305M
X14-306M
X14-307M
X14-308M
X14-309M

:
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• Packet 3A – Packet systems and tools
– Packet Network Overview and Components
– Packet Station HW & SW
– Accessing the network
– Standard workflow
– Working with messages

• Packet 3B – Applying packet to a field deployment
– Customizing message handling
– Miscellaneous Outpost settings
– Localizing packet
– Simulated field message exchange

• Packet 2 – Advanced Packet
– Manual packet messaging

1. Packet as a repeatable process

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 35
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1. First Shift… when assigned to start up a station

2. Initial station setup… equipment check-out

3. Packet Operations… managing the message flow   

4. Incoming Shift Change… if you are relieving someone else

5. Outgoing Shift Change… if you are being relieved

6. Securing Operations… when directed to shut down

Thinking in terms of a Packet Field Deployment
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1. First Shift
Packet Field Deployment Process
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2. Initial setup
Packet Field Deployment Process
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3. Packet Operations
Packet Field Deployment Process

… more
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3. Packet Operations (continued)
Packet Field Deployment Process
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4. Incoming Shift Change
Packet Field Deployment Process
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5. Outgoing Shift Change
Packet Field Deployment Process
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6. Securing Operations
Packet Field Deployment Process
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What is it
• Provides a reminder (job aid) for 

how to perform tasks that need 
to occur during a packet field 
deployment.

• Helps ensure task consistency, 
completeness, and operational 
alignment with SCCo RACES 
policies and procedures.

What it is not
• the only source of information on 

which you should rely.
• an official SCCo RACES 

deliverable.

Amateur Packet Radio
Field Reference (unofficial)
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Amateur Packet Radio
Field Reference (unofficial)

Where to find it…
https://bit.ly/PacketFieldRefFull (.pdf)… great 
for storing on your laptop or tablet.
https://bit.ly/PacketFieldRefBooklet (.pdf)… 
formatted to create an ½ size booklet; just 
print, fold, and staple in the middle.

Or contact kn6pe@arrl.net

45Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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What’s the plan for 2022?

• Maintenance release planned
– Fix reported bugs; Outpost enhancements, PackItForm enhancements

• Pop-up Packet Exercise
– 30-Apr-2022
– 8-Oct-2022

• Packet class schedule
– Packet Type IIIA 6-Aug-2022
– Packet Type IIIB 1-Oct-2022
– Packet Type II 5-Nov-2022

• And, new class content, such as…

46Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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A look at DIY KPC-3 alignment

• Ensuring your TNC-Radio is properly 
set is critical to packet operations.

• This includes both Receive Volume 
and Transmit Level.

• The KPC-3x Manuals are good at 
describing what to do but lack an 
end to end description of exactly how this is to be done.

• Being able to make these settings is critical to Packet field 
operations.

47Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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A look at DIY KPC-3 alignment

• Setting the Transmit level – you will need:
– The latest KPC-3x manual for reference.
– A KPC-3x to calibrate.
– An HT to receive the transmitted CAL signals.
– A dummy load (While not required, it is always 

good not to splatter your calibration tones all 
over the airwaves).

– A smartphone app such as Decibel X 
to display the audio.

• Watch for a details in 2022 on a DIY 
approach to setting the transmit level.

48Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved.
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For More Information

• Support
– See the Santa Clara County ARES/RACES web site packet page

• https://www.scc-ares-races.org/data/packet/index.html

– Join the packet discussion group

• Practice
– Send a message during the weekly packet net, either or both days

• https://www.scc-ares-races.org/data/packet/weekly-packet-practice.html
• Automated feedback to help you improve, verify you’ve got it right

– Participate as a packet operator at drills and other events
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Countywide Drill and SET
October 09, 2021

Andreas Ott, K6OTT
Revised 11-Dec-2021
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• Deployment Drill Exercise, minimal info was given 
to participants

• Travel to location and set up, be prepared to 
operate and conquer the unknowns

• “Dress Rehearsal” before incident deployment
• Same location as 2019 with activities FieldOps, 

NetControl, PacketOps and Shadowing

Drill Summary
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• Day of drill: ~ 250 person hours on ICS-211
• Preparation: estimated ~ 300 person hours
• Post-processing of paperwork and evals: 100 hours
• Ratio of participants to staff is only 3:1

More drill stats
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• Packet messaging throughput outpaced voice 
about 8:1! Thank you, Mark!

• We will use more Outpost scripting in the future
• Quality of submitted documents is going up
• Timing of shifts and spacing of exercises (MSEL)
• Equipment problems at netcontrol (radio trailer)
• Intermod (frequencies) and fundamental overload 

(radio hardware quality)
• Evaluations at drills: delays and problems removed 

required activities, evaluators in double-duty roles

Drill Feedback
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• 42 participants (incl. 1 visitor, 1 remote)
• Of these were 13 new hams, licensed 2017 or later
• 2 message nets, command net, packet + voice net
• 25 voice messages (?), 198 packet messages (!)
• 17 ”agencies” EOCs, shelters, rovers, packet
• 12 “jurisdictions” Xanadu plus participating cities
• All stations on emergency power
• At least 723 points total, maybe some more

Preliminary ARRL SET report 2021
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October Communications Drill 
and SET

Packet Operations Observations

Mark Laubach, K6FJC
Revised 24-Nov-2021
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• 2 shifts, 7 + 5 = 12 simulated shelters
• Automated EOC Outpost Script drove messaging passing 

Task Groups
• 2 P2 evaluations, 8 P3 evaluations conducted
• 193 messages passed (not including Delivered receipts)

• Time performance overview (in minutes) highly variable:

Packet Operations Summary

11 12 13 14 15 16 17 21 22 23 24 26
Check-In delta 
from shift start 00:57 01:14 00:43 01:34* 00:28 00:19 01:05 00:43 00:45 00:57 00:37 00:16

Immediate 
received from 
Check-in

00:36 00:17 00:49 00:32 00:11 00:26 00:39 00:39 00:29 00:31

Check-Out delta 
from Check-in 01:28 00:35* 01:20 01:52 00:57 01:25 01:32 01:42 02:36 01:45
Check-Out delta 
from shift start 02:11 02:09 01:48 02:11 02:02 02:08 02:17 02:39 03:13 02:01

* First check-in message was sent at 0:34, but not properly formatted
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Packet Operations Future Drill Considerations

• Increase training/emphasis on pre-event preparation
– Each participant needs to understand their set-up time for time mgmt
– Also, hopefully can reduce set-up time

• Expect some ”checklist education” on pre-operation readiness
– What needs to be done before Check-In

• When the exercise follows a “deployment” scenario:
– Defining a “shift” for packet didn’t work out as expected

• Highly variable set up times
• Management was not practicing “good” time management

– Expect an “operational period” to be defined within a Shift
• Model a served agency’s operational period requirements 
• Packet stations must be ready to go with Check-in at the start and will be 

closed down at the end
• Each participant will need to plan accordingly lead-time and tear down

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 57

57



2021 Year End Summary 12/11/2021

58Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

Monthly Packet Message Passing Practice

• The Outpost script-driven messaging passing automation 
worked well during the October exercise

• We are going to trial a monthly packet message passing 
practice on December 15th.  Starts at 09:00 on Wednesday the 
15th and ends on 17:00 on Wednesday the 22nd. 
– Zoom “office hours” on the evening of Wednesday the 22nd.

• Participants will need to sign up for the SCC Event
– Those that sign up will be assigned a tactical ID and ICS location

• This first trial will be a modified re-run of the SCCo exercise 
Message passing task group from 9 October

• Intent is to exercise 3rd party and operator-to-operator 
messages following a different scenario each month
– Keep it interesting and non “cut and paste”
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Net Control Training for 2022
Type III Part A & B

Type II

Mark Laubach, K6FJC
Revised 24-Nov-2021
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Plans for 2022

• Continued emphasis on pre-class homework 
– Expect updated course materials one week before class
– Homework will likely be moved to a separate handout / presentation

• Type III Part A
– Add focus on pre-assignment readiness and planning
– May include a new checklist or two…

• Type III Part B
– Focus will remain on operating, but some added emphasis on process 

flow (hint: checklist)

• Type II
– Rebalance of homework versus class material
– Will try to develop additional class participation exercise(s)
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Message Passing

Tim Howard, KE6TIM
Revised 04-Dec-2021
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• Added a homework component to class with a review 
during the first part of the class using message samples:

o http://bit.ly/Med-Base
o https://www.pge.com/en_US/safety/
o The P/N is 5bcDEש
o Meet at 37° 22’ 13.97” N, 122° 02’ 24.56” W
o ICP located at 37 22.2328, 122 02.4093
o 107A E 1st St Apt 3C

• Added Unknown Symbol/Character
• Added Superscript/Subscript
• Clarified other procedures to eliminate confusion and 

ambiguity

Class Changes
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• Message Handling Procedures 
were updated based on:

o Observations during drills,
events, and credential 
evaluations

o Feedback from this years 
two Message Passing 
Classes

o Discussions with our 
message passing team.
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Unknown Symbol or Character
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 Example:
o Written:  Send 50 Ꙃ today
o Spoken:  “send FIGURES fife zero <pause> UNKNOWN SYMBOL

<pause> today”

The receiver draws an empty box on their message form where the
unknown symbol would appear.

Send 50      today

• Example:
o Written:  We can use ab§δ instead
o Spoken:  “We can use MIXED GROUP alpha bravo UNKNOWN     

SYMBOL UNKNOWN SYMBOL <pause> instead”

We can use ab         instead
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SUBSCRIPT and SUPERSCRIPT

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 65

 Used to indicate the following character should be written a half-line 
lower (SUBSCRIPT) or higher (SUPERSCRIPT) than the rest of the text, 
such as subscripts and mathematical exponents

 Used with one character at a time 
 Does NOT remain in effect until the end of the group

• Examples:
o Written:  White blood cell count is 105

o Spoken:  “white blood cell count is FIGURES one zero 
SUPERSCRIPT fife”

o Written:  Model XS463

o Spoken:  “model MIXED GROUP x-ray sierra four SUBSCRIPT six 
SUBSCRIPT tree”
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SUBSCRIPT and SUPERSCRIPT
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• When given a chemical symbol to send, if possible, ask the message
author to provide the common English word for the chemical.
If that is not possible, then use the procedure outlined above.

• Written by message author:  H2O2

Corrected by message author: H2O2 Hydrogen Peroxide

• Spoken:  hydrogen peroxide  (you might use I SPELL here to ensure
precise copy
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INITIAL(S)
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• Identifies one or more letters to follow
• Used for non-word letter groups
• Voice each letter phonetically
• Leave a pause after the last letter to help separate it from groups
• that follow
• Use for letter groups such as Initials, Abbreviations and Acronyms
• Is immediately followed by white space or a punctuation mark  . , : ; ! ?

• These are Initials
o ARRL
o St.
o Dr.
o EOC
o CA
o T.   (As in James T. Kirk)
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FIGURE(S)
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• Identifies one or more numerals to follow
• Voice each digit separately
• If anything, other than a numeral is present, it becomes a

MIXED GROUP, MIXED GROUP FIGURE(S), or MIXED GROUP SYMBOL(S).

• These are Figures
o 145
o 35
o 13253

• These are NOT
o -145   (Mixed Group Symbol)
o 13,253   (Mixed Group Figures)
o 2/3  (Mixed Group Figure)
o 146.595 (Mixed Group Figures)
o 408.555.1212 or 408-555-1212  (Telephone Figures)
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Symbols
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Voicings are shown in bold.

Voice hyphenated words as if they 
are a single-word.

Punctuation symbol voicings are 
underlined.

Context is shown in italics.

\ Pronunciation \ is between 
backslashes.

Some symbols have context sensitive names
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Recommended 
Field Groupings

See examples of the 
other forms in Appendix A 
of the Message Handling 
Procedures document
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ICS 214 and ICS 309
revised to add a 
signature block

Form Updates
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SCCo BBS System update

Andreas Ott, K6OTT
Revised 11-Dec-2021
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• Slowly emerging from Pandemic restrictions: we 
were able to access field sites during second half of 
year

• Replaced 3 of 4 BBS computers with new 
hardware, virtualized BBS servers, backups

• Monitoring of network and power status
• Minor device and component maintenance, 

software upgrades

Accomplished in 2021
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• Finish hardware replacement of BBS computers
• Plan for firewall replacement
• Add subscriber stations (at EOCs, hospitals)
• Plan for County EOC relocation ~2024
• Software improvements (servers and JNOS) – Big 

Thanks to Thomas KK6FPP and John W6JMK
• Possible automation of Practice Packet NetControl

Plans for 2022
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Changes to FCC
Station Evaluation Rules

Yes, you need to do an 
RF Safety Evaluation

Andreas Ott, K6OTT
Revised 11-Dec-2021

Acknowledgement: Morris Jones, AD6ZH
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Before
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Before
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• From ARRL ARLB011: 
The new rules do not change existing RF exposure (RFE) limits but do require that 
stations in all services, including amateur radio, be evaluated against existing limits, 
unless they are exempted. For stations already in place, that evaluation must be 
completed by May 3, 2023. After May 3 of this year, any new station, or any 
existing station modified in a way that's likely to change its RFE profile - such as 
different antenna or placement or greater power - will need to conduct an 
evaluation by the date of activation or change.

• https://docs.fcc.gov/public/attachments/FCC-19-126A1.pdf
(159 pages, contains submitted comments, and math)

FCC Rule and Order 19-126
Effective May 2021
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• ARRL web pages (info, FAQ, calculator)
• http://www.arrl.org/rf-exposure
• http://www.arrl.org/rf-exposure-calculator
• QST article September 2021, pp. 60-62
• To get proof of evaluation: do it on ARRL web 

calculator, and then print to PDF and save file
• Controlled and uncontrolled exposure (have 

different maximum permissible exposure limits), 
you want to note the two distances for your setup

But how?
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• RF energy gets absorbed into your body. It heats 
up tissue over time, and the more you transmit. It’s 
accumulative, unless you let your tissue cool down 
in between transmissions (duty cycle).

• Human body is most susceptible to 30-300 MHz
• Controlled (your and your household) versus 

uncontrolled exposure (bystanders) have different 
maximum permissible exposure limits.

And why would you care?
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• All stations! The way I read the R&O, this applies to 
your home station or your EOC, and you have until 
May 2023 to comply if you have had that station 
without changes since before May 2021, but it also 
applies to stations we (temporarily) set up in the 
field for drills and exercises, and after you make a 
change to any station.

For which stations?
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• It depends, they are the same as the old safe 
distances, but no more easy tables for lookup, and 
you will be surprised by what “used to be safe”

• Calculation is somewhat involved, as the rules are 
based on field strength and power density, two 
parameters not easily accessible; and dependent 
on the transmit frequency

• Variables to be filled in: transmitter power, 
feedline loss, antenna gain/loss, frequency, 
emission mode and transmitting duty cycle

So, what are the new safe 
distances?
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• Use low(er) power, as you should anyway
• Keep radio antenna away from body when feasible, 

or keep body away from radio antenna (heh)
• Let body cool down, exponential decay, take 

breaks in between transmissions (lower duty cycle)
• Keep transmissions short, efficiency as a goal
• Check common use cases: body-worn radio, 

magmount antenna on car roof, pushup mast
• Use conservative defaults as input

Easy to understand principles
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• Radio, antenna and feedline datasheets
• The ARRL calculator has a references, also to the 

math and code they use
• The former OET Bulletin 65 and Supplements have 

not been updated since the R&O became the law 
and are still “under review” https://www.fcc.gov/general/oet-bulletins-line

Auxiliary documents

85



2021 Year End Summary 12/11/2021

86Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

Copyright © 2021 Santa Clara County ARES®/RACES.  
All rights reserved. 86

86



2021 Year End Summary 12/11/2021

87Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 87

Live demo of ARRL calculator
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EC Reports
2021 Volunteer Hours

Andreas Ott, K6OTT
Revised 11-Dec-2021

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 88

88



2021 Year End Summary 12/11/2021

89Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 89

• First 7 months:
89 reports
• 4 recent months:
66 reports

Overview 2021
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• Thank you for submitting reports and “activating” 
hours to be counted

• We will backfill data Jan-Jul 2021 by January, so 
that a full report will come out of the new system

• Please be patient and do not enter old data on 
your own, but go back and check (update?) when 
we tell you that it’s ready

Data entry
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• Jan – Jul 2021:  approx. 8,133 hours
• Aug – Nov 2021: approx. 5,264 hours
• Dec 2021 estimate: 1,100 hours
• Year 2021 summary: approx. 14,500 hours *
(Yes, there were more activities since July after 
restrictions were lifted, but we also think we are 
captioning more hours and more accurately through 
better reporting.)
* The equivalent of $ 2.175 M at minimum wage

Preliminary stats 2021
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2022 Training

Judy Halchin, KK6EWQ
Revised 3-Dec-2021
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• All the regular classes were offered
• Zoom-to-classroom transition

• Plenty of masks and plenty of space
• Largest classes stayed on Zoom

• Field Operations classes over the air
• Online class evaluation forms

2021 Review

93



2021 Year End Summary 12/11/2021

94Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 94

• Another good year for Gumby
• Watch your email and the sign-up 

pages
• Full slate of classes scheduled
• Packet practice and mini-drill – April 30
• Annual drill September 17 – mark your 

calendar

2022 – What to expect
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Credentials

Tim Howard, KE6TIM
Revised 30-Nov-2021
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Clarification of Requirements
• To earn a Credential, participation in Training Classes, Exercises, 

and Public Services events must be completed within two years.

• Participation in Exercises and Public Service events can not be used 
for more than one credential.  For example: if a Public Service event 
is used for your C4, it can not also be used for an F3 Credential.  A 
different Public Service event is required.

• Participation in an activity must be in the same role as the 
credential it is being applied to.  For example:  if you are working on 
a P3 Credential, the duties you performed at the activity must be 
packet-related.  Working as a Field Operator will not satisfy the 
requirements for a Packet P3 Credential.

• Participation must be at a credential-approved activity.
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Clarification of Requirements
• Equipment checks are good for one-year.  For example: if you 

completed an F3 equipment check, you can use that for an N3 
within one year and do not need to repeat the equipment check. 

• Where equipment requirements are different, you would only need 
to have the additional equipment checked.

• Radio familiarity and Knowledge tests are also valid for one year.

• Again, where requirements are different, only the additional 
requirements would need to be done.
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Clarification of Requirements
• To maintain Credentials, you must

o Take part in two credential-qualified activities (exercises, 
events, incidents) within each two-year period

o Or take part in one credential-qualified activity and at least one 
“End of Year Summary’ class within a two-year period. 

• Failure to do so will result in loss of Credentials.  We made an 
exception for 2020 but will be looking at participation again moving 
forward.

• There is a reinstatement process outlined in the “Credential 
Program Handbook” that can occur within two years of losing a 
Credential.

Copyright © 2021 Santa Clara County ARES®/RACES.  All rights reserved. 98

98



2021 Year End Summary 12/11/2021

99Copyright© 2021 Santa Clara County ARES/RACES.  All Rights Reserved.

COVID - Credential Requirement Extension
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Q&A
All Training Staff
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Thank You!

Please check your email and follow the instructions to 
complete and return the Course Evaluation. 

If you have questions or feedback about this or other training 
activities, you can join our Training discussion group.

https://scc-ares-races.groups.io/g/training
This is a moderated group.

See you at a training class or exercise next year!
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